PolyView Help Contents

PolyView is a multi-threaded 32-bit Microsoft Windows 95 and Windows NT application which provides
viewing, file conversion, and image manipulation support for GIF, JPEG, photo-cd, PNG, TIFF, and
Windows and OS/2 BMP files.
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Registering PolyView

PolyView is distributed as shareware. This allows you to try it out to determine if it fits your needs. If you
decide you like PolyView and intend to keep it and use it, you are obligated to register with Polybytes.
The current registration rate for PolyView is:

Single user license: $20.00

Registration Benefits

Registered users receive a license key number from Polybytes that enables several features of the
program not accessible to non-registered users. These features include:

Export of Run Length Encoded (RLE) bitmap files

Export of 16 bit bitmap files

Export of Portable Network Graphics (PNG) files

Export of GIF files

Multiple image file select from the file open dialog

Printing images

Storing of user supplied text in exported or saved image files

When the registration key is received, execute the Licensing Information dialog under the
Registration menu to enter the key information. It is important to enter the information exactly as
received from Polybytes.

A user registration and the associated key does not expire and will work with all future versions of
PolyView. The user registration information is stored in the Windows Registry. If for some reason this
information is lost from the registry, simply rerun the Licensing Information dialog and re-enter the
key information.

Registration Restrictions

Registered users are required to abide by the provisions of the licensing agreement with Unisys
Corporation concerning the usage of LZW-GIF compression/decompression technology.

How to Register

Users in the United States can register PolyView by sending a check or money order for the
registration amount to:

Polybytes
3427 Bever Avenue S.E.
Cedar Rapids, lowa 52403

Registration checks sent directly to Polybytes should be made payable to Polybytes.

Registrations for PolyView are also handled by Kagi Shareware services. Kagi Shareware can
process payments in many forms, including personal checks, foreign currency, and a variety of credit
cards. In addition, an electronic mail or FAX registration service is available from Kagi Shareware.
The companion Register program provides the access to Kagi Shareware registration services for
the purpose of registering PolyView. To run Register, choose the Register Now option from the
Registration menu. To contact Kagi Shareware for information about their service send electronic
mail to kee@kagi.com or point your WWW browser to http://198.207.242.3/ (the final slash is
important, so be sure to include it!).



Please be sure to include your electronic mail address with your registration so that we can provide you
with more timely information about PolyView. Registration key information is sent to registered users via
electronic mail if your electronic mail address is available. Otherwise the information will be sent via the

US Postal Service.



Execution Options

Running PolyView

PolyView.exe is the executable file which contains the implementation of the PolyView application.
PolyView can be executed by Running it from the Program Manager or File Manager under Windows
NT. Windows 95 users can run PolyView from the Windows 95 Explorer or through the many
varieties of Windows 95 shortcuts that can be created.

Drag-and-Drop

Drag-and-drop a file on a running PolyView application, on a PolyView shortcut, or on a minimized
PolyView icon, to send the file or files to PolyView. Depending upon the setting of the Drag and Drop
File Actions property of the File Properties Tab of the Properties dialog, PolyView will

Create a new window for each dragged file

Create a new slide show from the dragged files

Add the new files to an existing slide show

Start a slide show if the file is a Slide Show Script file

See the information about Full Screen Display Modes for an explanation of slide show mode
characteristics.

Caution: If PolyView is configured to create a new window for each dragged file and a large number
of files are "dropped", then PolyView can fairly quickly use up large amounts of the real and virtual
memory resources in your system. If this occurs accidentally, the multithreaded nature of PolyView
will allow you to correct your mistake by choosing the File:Exit command to terminate file
decompression and release all resources.

Limitation: When multiple files are dragged from the Explorer to a PolyView shortcut, the method
used by the Explorer is to pass the file names on the internal command line used to execute
PolyView. Since there is a limit to the number of characters allowed on an application command line,
there is a significant limitation to the number of files that can be dragged at once using this method. If
the line length limit is exceeded, one of two things will happen. Under Windows 95 a notification will
be issued that there is a problem, and PolyView will not be executed. Under Windows NT the file
name at the end of the command line may be truncated, resulting in an error message from
PolyView. The work-around to this problem is to execute PolyView first and then drag and drop files
on it.



Windows Registry Usage

PolyView uses the Windows registry for the storage of all information pertaining to individual user
settings from the Properties menu, most recently used file list, and the most recently used directory. The
polyview.ini file in the windows directory (WINNT35, WINDOWS, etc.) created by PolyView versions prior
to 1.70 is no longer needed and may be discarded.

PolyView automatically registers itself with the File Manager or Windows 95 Explorer upon startup, but
only for the purpose of storing user preferences under the HKEY_CURRENT_USER\Software\
Polybytes\PolyView key. The association of file types with PolyView is done only by user direction from
the Register File Types dialog which is selected from the Options menu.



The Toolbar and the Status bar

The Toolbar
The PolyView toolbar contains buttons for:

Opening image files

Copy and Paste

Printing the visible portion of the current image

Invoking full screen display mode

Manipulating the image appearance

Viewing the PolyView About dialog box

Tool Tips

The function of a toolbar button can be determined by placing the mouse cursor over the button.
After a few moments a small caption will be drawn near the cursor indicating the function of the
button.

Toolbar Positioning

The PolyView toolbar is a docking toolbar. This means that it can be grabbed with the left mouse
button and dragged to a new position within the PolyView window. If positioned against an edge of
the window it will be docked there. The toolbar can also be left floating anywhere in the window, or
made invisible through the View:Toolbar command.

The Status Bar

The Status Bar contains an indicator which displays the action a highlighted menu option will
perform, and a "Working" indicator which is displayed when a PolyView background thread is
working on reading or saving a file, or adjusting the appearance of an image.



Full Screen Display Modes

The File:Slideshow, View:Full Screen View, and View:Auto-browse Images commands display the
current image using the entire display screen. Images displayed in full screen mode will be downscaled
to fit within the screen boundaries if the raw image size exceeds the screen pixel dimensions.

Automatic Image Cycling

In slide show or auto-browse modes, images will be changed at the rate indicated by the Browsed
Image Display Time property of the Browsing Properties Tab of the Properties dialog.

Randomized Slide Shows

If Randomize Slide Shows has been selected from the Browsing Properties Tab of the Properties
dialog then the ordering of images displayed in a slide show will be randomized.

Manual Image Cycling

While browsing images in full screen mode, the left and right mouse buttons can be used to manually
cycle through the selected images, canceling any timed image cycling that is in progress. The left
mouse button causes the display of the previously displayed image, and the right mouse button
causes the display of the next image.

Note 1: When a slide show is manually browsed there will be periods of time after a new image is
displayed when the next image will not be available for display. During this period while the next
image is decompressed the system displays an hourglass cursor. PolyView attempts to load the next
image to be displayed by assuming that it is the next file in the slide show list in the direction that
was directed by the last mouse click. When a manual slide show is initially started, PolyView displays
the first image and begins reading the next image to the right (the second image in the list of slide
show files). At this time the last file in the slide show file list is not loaded, so a left mouse button click
after the hourglass cursor disappears will start it loading. When the hourglass again disappears a left
button click will move to that image.

Note 2: Under Windows 95 a right mouse button click near the top of the screen will invoke the
standard Windows 95 popup menu, interfering with the full screen mechanisms used by PolyView.
There is currently no workaround for this problem except to avoid this area of the screen with the
mouse cursor while using the right button to cycle images.

Canceling Full Screen Mode
Full screen mode is canceled by entering a key from the keyboard.



Panning and Zooming Images

Panning

Images that do not fit within a displayed window can be panned (positioned) by using the scroll-bars
that appear on the window.

Zooming the Image
PolyView can change the magnification of a displayed image in several ways.

The View:Zoom In command increases the magnification of a displayed image by about 50%. If the
image displayed at the resulting magnification level will fit entirely within the dimensions of the
PolyView viewing area, then the image window size is increased. Otherwise, the original window size
is maintained, with the center of the newly magnified image the same as that at the previous
magnification. In the latter case, scollbars are added to the image window.

The View:Zoom Out command changes the magnification and image display position to the
conditions which existed prior to the previous View:Zoom In command.

A more interactive zoom is available by using the left mouse button to draw a rectangle around the
area to be displayed in the magnified image. When the button is released the image will be rescaled.
The View:Zoom Out command can be used to go back to the previous magnification. (This action is
only available if the Enable interpolated zoom option of the General Properties Tab of the Properties
dialog is not selected.)

Interpolated Zoom

If the Enable interpolated zoom option of the General Properties Tab of the Properties dialog is
selected then a zoom operation invoked by drawing a rectangle around an area of an image causes
a new window to be created which contains an interpolated version of the area of interest. The
interpolation method of zooming typically results in much better looking images than non-interpolated
zooming. As usual, the tradeoff is speed and memory usage versus image quality. The interpolated
image takes significantly longer to produce (especially on 386 systems without math coprocessors)
and causes a new internal memory structure to be allocated to hold all the data associated with the
new image.

Recommendation: Leave the Enable interpolated zoom option disabled so you can quickly zoom in
on an area of interest in an image. Once the area is displayed at the appropriate scale use the
Smooth to New Window command from the Options menu to create a smoothed version of the
image view you are looking at.



Image Appearance Manipulation

The appearance of an image can be manipulated using the brightness/contrast/color/rotation selections
of the Options menu, or via the appearance manipulation buttons on the toolbar.

The following selections are available. The actions of all but the Gray Scale and Rotation selections are
modified by the appropriate adjustment percentage properties of the General Properties Tab of the

Properties dialog.

Brighter+
Brighter-
Adjusts the brightness level of the current image.

Contrast+
Contrast-
Adjusts the contrast of the current image.

Color+
Color-
Adjusts the relative color saturation level of the current image. (Disabled for gray scale images.)

Red+
Green+
Adjusts the red/green tint of the current image. (Disabled for gray scale images.)

Gray Scale
Converts the current image to gray scale. (Disabled for images which are already gray scale.)

Rotate Clockwise
Rotates the current image clockwise by 90 degrees.

Rotate Counter Clockwise
Rotates the displayed image counter clockwise by 90 degrees.



Properties

The PolyView Properties dialog box, accessed through the Properties selection of the Options menu, is
used to control the user preferences for the operations performed by PolyView during its operations. The
various properties are organized under the tabs of the dialog box. These tabs include:

Properties Dialog Tabs:

File Properties Tab
General Properties Tab
Browsing Properties Tab
JPEG Properties Tab
MRU File List Properties



File Properties Tab

The file properties are available from the Files tab of the Properties dialog. These include:

Drag and Drop File Actions

Options to control whether files dragged from the File Manager and dropped on PolyView create new
image windows, or are used to create or augment a slide show. Two options are presented:

Create a window for each file
Create a slide show from files
Add to existing list

Image File Open Actions

Options to control whether a file opened by PolyView creates a new image window or replaces the
current image window. Two options are presented:

Create New Window
Replace Current Window

Prompt for file save on exit

If this option is checked then PolyView will remember if the appearance of the image is altered and
will allow a last chance to save the image when the image is closed.



If this option is chosen, then each file dragged and dropped on PolyView will create a separate image
window. Caution: if a large number of files are dropped, then correspondingly large quantities of memory
resources will be consumed.



If this option is chosen, then a group of files dragged and dropped on PolyView will be used as the file
list for a slide show and the slide show will be automatically entered.



If this option is chosen, then each file opened by PolyView will be displayed in a separate, newly created
window.



If this option is chosen, then each file opened by PolyView will be displayed in the current window,
replacing any existing image. If no images are currently being displayed then PolyView will create a new
window for the image. Note: If multiple files are dropped on PolyView when this option has been
selected, then only the first file will be opened.



If Create a slide show from files has been selected, then this option controls whether the dropped group
of files replaces an existing slide show list or is added to it. Note: this option will be disabled unless
Create a slide show from files has been selected.



General Properties Tab

The general properties are available from the General tab of the Properties dialog. These include:

Image Adjustment Percentages

These controls set the percentage change that will occur when the Image Manipulation commands
are used to adjust brightness, contrast, color saturation, and red/green tint. Setting the Brightness
Adjustment Percentage value to 10, for example, will cause the Options:Brighter+ command to
increase the overall brightness of the image by 10 percent. The allowable range for each item is 1 to
20.

Default One-For-One Mapping

This option controls the way PolyView deals with images that are larger than the maximum size
image that can be displayed in the current viewing area. If Default One-For-One Mapping is selected,
then PolyView will prepare the largest size window possible and equip it with scroll-bars to enable
panning around in the image. If Default One-For-One Mapping is not selected, then PolyView will
scale the image to fit within the viewing space. In this case the View:One-for-One Mapping command
can be used to achieve the same view of the image.

Disable All Editing (Viewing only)

Turns off the retention of the device independent bitmap associated with an image. With certain
display modes this will reduce memory consumption and increase file loading speed. It will also,
however, disable most editing functions including color manipulation, rotation, copy, save, export,
etc.

Enable interpolated zoom

This option controls the way PolyView zooms an image when a rectangle within the image is drawn
with the mouse to define an area to be zoomed. If interpolated zoom is enabled then a new window
will be created from the contents of the defined area. The size of the new window will be the
maximum size that can be created within the confines of the current viewing area within PolyView.
An interpolation algorithm will be used to present as realistic an image as is possible based on the
original resolution of the image.

If interpolated zoom is disabled, then a quick zoom will be executed which simply rescales the
current window to display an enlarged version of the area of interest.

Photo-CD Upsizing

The Photo-CD Upsizing options control the way PolyView selects the image size to use from a
Photo-CD image file.



Photo-CD Upsizing

The algorithm that PolyView uses to select the display image size of a photo-cd file depends on the
Enable Photo-CD Upsizing option of the General Properties Tab of the Properties dialog.

If upsizing is not enabled, then PolyView chooses an image size which fits within the dimensions of the
full screen viewing area, yielding the most accurate display of the image. For example, if a horizontal
image is to be displayed on an 800x600 resolution display, then the 768x512 image size will be chosen.
On the same display, however, a vertical image will be displayed in a 256x384 format, since the next
available size of 512x768 will overfill the screen in the vertical direction.

If upsizing is enabled, then PolyView chooses an image which fills the screen to the Screen Fill
Percentage in at least one direction. For example, consider the case where a 75% Screen Fill
Percentage has been chosen. On an 800x600 display, a horizontal image will be displayed in the
768x512 image size because this fills the screen to 96% in the horizontal direction, and 85% in the
vertical direction. For a vertical image a 512x768 image will be chosen, because the next smaller size of
256x384 will fill the screen to only 32% in the horizontal direction, and 64% in the vertical direction. In
this case, the 512x768 image will be "shrunk" to exactly fill the available display area.

Caution: upsizing can cause PolyView to use a significantly larger amount of memory during photo-cd
image decompression and display. Specifying a 90% Screen Fill Percentage on an 800x600 display will
result in PolyView choosing a 1536x1024 image. During decompression this size image requires a 4.6
Mbyte memory structure to be allocated for the storage of a device independent bitmap. On a 24 bit
display the resulting device dependent bitmap is also 4.6 Mbytes in size, so the peak memory
requirement to display this image is more than 9.2 Mbytes. This may lead to excessive disk activity and
performance degradation on memory challenged systems.



Browsing Properties Tab

The browsing properties are available from the Browsing tab of the Properties dialog. These properties
include:

Browsed Image Display Time

The number of seconds an image is to be displayed in auto-browse or slide show modes. This is the
minimum time for the display of the image in slide show mode. The next image load is started when
an image is displayed, so long image load times may increase the image display time.

Timed Browsing Mode

These properties control the method used to terminate auto-browse or slide show mode. Three
alternatives are provided:

Cycle Images Once
Cycle Images Continuously
Cycle Images Manually

Randomize Slide Shows

This property controls the order in which images are displayed during slide shows. If selected then
the image display order will be randomized. If not selected, then the image display order will be the
same as the order shown in the slide show open dialog, or the order of the files listed in a slide show
script file.

Ignore read errors during slide shows

This property controls the behavior when image file decode errors occur during slide shows. If
checked then any errors that occur will be ignored and the offending file will just be skipped over. If
unchecked then any error will abort the slide show with a message indicating the file that caused the
problem. Note: if an error occurs while reading the first file to be displayed in a slide show then the
show will always be aborted.

Display Filenames with Full Screen Image

This property controls whether or not the name of the displayed image is displayed along with the
image when in full screen mode.



The images are cycled once from the beginning to the end of the list. When the end of the image list is
reached the full screen mode will be terminated.



The images are cycled continuously. When the end of the image list is reached the list is restarted from
the beginning. User intervention via the mouse or the keyboard is required to interrupt the display
cycling.



Image cycling is controlled by the user via the mouse or the keyboard. The right mouse button advances
to the next image in the list. The left mouse button advances to the previous image in the list.



JPEG Properties Tab

The JPEG properties are available from the JPEG tab of the Properties dialog.

DCT Arithmetic Method

The PolyView JPEG algorithms provide several methods for performing the Discrete Cosine
Transform (DCT) used during JPEG file reading and writing. The methods available are:

Accurate Integers

Fast Integers
More Accurate Floating Point

Chroma Component Upsampling Method

The Chroma component upsampling method controls the speed and accuracy of certain color
manipulations performed during JPEG file reading. The methods available are:

Slow, careful, and accurate
Fast, but less accurate

Output Quality Factor
Controls the relative quality of the image resulting from saving to a JPEG format file, and is
proportional to the resulting size of the file. (Higher quality images result in larger files.) The
PolyView default value of 50 is a reasonable compromise between output quality and file size.



Fast but inaccurate integers - this is the fastest method on most machines, but may suffer from
degraded image quality. For many images there will be insignificant visible degradation.



Slow but accurate integers - this method is slower than the fast integer method, but achieves high
quality results.



Fast or slow but accurate floating point - this highly accurate method may be the fastest on some
machines, but on machines without floating point capability will be VERY slow.



Chroma (color) upsampling is performed very carefully and accurately. This is the slowest method.



Chroma (color) upsampling is performed with a sloppier method that leads to some image degradation.
This method is much faster, however, and the degradation is frequently not detectable.



Credits and Acknowledgments

The Graphics Interchange Format(c) is the Copyright property of CompuServe Incorporated. GIF(sm) is
a Service Mark property of CompuServe Incorporated.

The LZW compression/decompression technology in GIF files is licensed under U.S. Patent No.
4,558,302 and foreign counterparts.

Microsoft Windows NT and Windows 95 are registered trademarks of the Microsoft Corporation.
0S/2 is a registered trademark of the International Business Machines Corporation.
JPEG file support in PolyView is based on the work of the Independent JPEG Group.

Tagged Image File Format support is based on the work of Sam Leffler. This work was made available
according to the following statement:

Copyright (c) 1988, 1989, 1990, 1991, 1992 Sam Leffler
Copyright (c) 1991, 1992 Silicon Graphics, Inc.

The Photo-CD decompression algorithm in PolyView was derived from the algorithm in the XLI
application, an X Windows based image viewing utility. This work of many authors was made available
according to the following statement:

Copyright (c) 1989, 1990, 1991, 1992, 1993 Jim Frost, Graeme Gill and others.
Copyright 1989 Massachusetts Institute of Technology

Copyright 1990 Mark Majhor

Copyright 1989, 1990 Kirk L. Johnson

Copyright 1989, 1990, 1991 Jim Frost

Copyright 1991 Tim Northrup

The Portable Network Graphics (PNG) format software is based on the Zlib compression software. The
following statement applies to its use:

(C) 1995 Jean-loup Gailly and Mark Adler
The PNG library itself is covered by the following copyright statement:

Copyright (c) 1995 Guy Eric Schalnat, Group 42, Inc.
Contributing Authors:
Dave Martindale
Guy Eric Schalnat
Paul Schmidt
Tim Wegner

Lastly, Polybytes would like to acknowledge the many comments and suggestions received from the
users of PolyView. And a special thanks to Albert Collver for his untiring critiques of the operation of
PolyView under Windows 95.



The PolyView Warranty

THE POLYVIEW SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL LARRY REEVE OR POLYBYTES BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE
POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.



Supported Formats

PolyView supports the following standard graphics formats for image viewing:

Bitmap (BMP.

Graphics Interchange Format (GIF)

Joint Photographics Experts Group (JPEG
Photo-CD

Portable Network Graphics Format (PNG)
Tagged Interchange File Format (TIFF)



TIFF files come in many shapes, sizes, and colors. Because of this it is virtually impossible to guarantee
that all possible combinations of TIFF storage techniques will be interpreted and rendered correctly.
PolyView does, however, support 1-4-8 bit grayscale images, 8 bit color mapped images, and 24 bit
RGB images. These formats are supported with a variety of compression methods, planar
configurations, and in both tiled and non-tiled forms.



Photo-CD is the Kodak Photo CD format. PolyView can extract any of the image sizes stored within
these files.



JPEG format files containing 8 and 24 bit images are read and displayed by PolyView.



GIF file images are read and displayed by PolyView. PolyView ignores non-image related information
found in GIF 89a files.



BMP format files in both Windows and OS/2 formats are read and displayed by PolyView.



File Menu

Open...

Presents a standard file-open dialog box from which a graphics image file or a slide show script can
be selected for display. Newly opened files will be created in a new window or in an existing window,
depending on the settings of the Image File Open Actions property of the File Properties Tab of the
Properties dialog. If a Windows 95 Explorer dialog is available for the file-open dialog box, then
multiple files can be selected at once using the standard technique of combining the control and shift
keys with mouse button selections.

Save

Saves the current file in the original format, subject to the default settings for that format as specified
by the Properties dialog. This menu option is enabled only for images that are in a format supported
by PolyView for file saving.

Close
Closes the currently displayed image.

Delete

Deletes the file associated with the currently displayed image and closes the image window. A
confirming dialog box will be presented to reduce the chances of accidentally deleting an image.

Export Image...
Exports the current file in a format supported by PolyView for file saving.

Page Setup...
Invokes the Page Setup dialog for the specification of print margins and centering options.

Print Setup...

Invokes a standard printer setup dialog for the specification of the printer to use, properties for the
printer, page orientation, and other print related items.

Print
Brings up a choice of printing the current image in its entirety, or printing just the currently visible
portion of the current image. Either choice leads to a dialog box which offers another opportunity to
change printer characteristics before printing commences.

Print Preview

Brings up a choice of previewing the printing of the current image in its entirety, or previewing just the
currently visible portion of the current image. The print preview window which will be displayed on
the screen as a result of this command shows the general relationship of the image to the page it will
be printed on. In most cases the colors seen in the print preview will not reflect the actual color to be
printed, but the preview display can be useful to view the proportions and positioning of the image
with respect to the printed page.

Slide Show...
Presents a modified file-open dialog box from which a list of images can be created for use in a full
screen slide show presentation. A pre-display rotation can be selected for individual image files if the
default orientation of the image file is not correct. In addition, the timing of the display of the
individual images in the slide show can be specified.

The behavior in the full screen display mode is controlled by the settings of the Browsing Properties



Tab of the Properties dialog.

Save Slide Show...
Saves the current slide show in a slide show script file.

Image Properties...

Displays a dialog box which provides information about the specific properties of the currently
displayed image and, for registered users, the opportunity to add or modify the comments for
subsequent saving to any supported file format which can contain embedded comment text, such as
JPEG.

Recently Opened File List

A list of the most recently opened image files. Selecting one of these file names is equivalent to
selecting it again through the Open... command. The characteristics of this list can be manipulated
through the MRU tab of the Properties dialog.

Purge recent file list
Immediately clears the most recently opened image file list from the file menu.

Exit
Closes all image windows and exits PolyView.



View Menu

Zoom In and Zoom Out
See Panning and Zooming.

Auto-browse Images

Presents a full screen slide show of the currently open images. The behavior in the full screen
display mode is controlled by the settings of the Browsing Properties Tab of the Properties dialog.

Full Screen View
Displays the current image in full screen mode.

One-for-One Mapping

Changes the display of the current image to be actual size. The default PolyView behavior when
opening large images is controlled by the Default One-For-One Mapping property of the General

Properties Tab of the Properties dialog.

Resize to fit main window

Scales or rescales the current image to better fit the display area in the PolyView main window. A
large image will be shrunk to fit the display, but small images will not be expanded.

Toolbar
Enables or disables the display of the toolbar.

Status Bar
Enables or disables the display of the status bar.



Options Menu

Image Appearance Adjustments
See Image Appearance Manipulation.

Smooth to New Window

Creates a new window from the currently visible area of the current image. The new window is the
same size as the current window but is created using an interpolation algorithm which eliminates
much of the pixelation effects which occur when an image is magnified by rescaling.

Change Resolution...

Invokes the New Image Dimensions dialog to specify the dimensions of a new image which is to be
created from the current image. This command is useful for creating wallpaper bitmaps from images
which are not large enough to fill the entire screen.

Transparent Color...

Invokes the Choose Transparent Color dialog to specify the color to represent transparency if the
current image is exported as a GIF file.

Properties...
See Properties.

Register File Types...
See Register File Types.



Window Menu

New Window

Creates a new view of the current image. This might be useful for viewing separate portions of the
same image at the same time.

Arrange Icons
Arranges the current image icons in an orderly fashion within the PolyView main window.

Current Image List
The list of image files currently open. Select an image from this list to make it the current image.



Help Menu

Help Contents
Displays the contents page of the PolyView help system.

Search For Help On
Search the PolyView help system for information on a specific subject.

About PolyView
Displays a dialog box with information about the current version of PolyView.

Note: Context sensitive help is also available by pressing the F1 key. Context sensitive help directs the
user to the help topic appropriate to the action currently being performed.



PolyView Version History

2.21
Added Transparent Color dialog for specification of GIF transparency.

File type used for the last file exported is now remembered as the starting type for a new export.
Fixed incompatibilities with Windows 95 taskbar during full screen modes.

Fixed a problem where errors occurring during manual slide shows were not ignored.

Fixed a problem with recovering from certain varieties of GIF file corruption.

Fixed several problems with image sizing and full screen behavior when the PolyView toolbar is
floating instead of docked on a window edge.

2.20

Changed method of opening a file in one-for-one mapping to eliminate resolution change at end of
read.

Added interpolated zoom.
Added the Change Resolution and Smooth to New Window commands.

Added option to the Browsing Properties Tab of the Properties dialog to ignore errors during slide
shows.

Corrected behavior when Prompt for file save on exit is in effect and a close on a created window is
attempted.

219
Added printing.

Corrected the behavior which occurs when the display resolution is changed under Windows 95
while images are being displayed.

2.18
Added individual image timing during slide shows.

PNG files are now written as 8 bit gray scale even if the source is 24 bits if it is found that the source
is really gray scale in disguise.

Added exporting to GIF files.
Added exporting to progressive JPEG files.
Added separate storage of open and save directory paths.

Added Most Recently Used file list manipulation functions.



Removed support for LZW compressed TIFF files due to patent licensing restrictions.
Fixed a bug which caused incorrect operation of the Browsing Properties dialog.

217
Added support for reading progressive JPEG files.

Restored the ability to convert 8 bit images to JPEG format.
Added saving (exporting) to PNG format files.
Added slide show randomization.

2.16

Fixed a bug which caused image size problems when the toolbar was positioned at the right or left
edge of the viewing area.

Fixed a bug which caused name recognition problems for folders with names which ended
in .GIF, .JPG, etc.

Enhanced the image context menu.

Added .JPEG and .TIFF as recognized file types.

Added support for viewing PNG files.

Enhanced Register File Types dialog to show current PolyView registrations.

215 Fixed a bug which prevented the file-open dialog from working correctly.
214 Added saving to 8 bit RLE bitmap format.
Added saving to 16 bit bitmap format.
Added multiple file selection from Explorer file open dialog.
Added editing and saving of comments to JPEG files.
Added user registration for feature set enabling.
2.13 Corrected processing of multiple files dragged to a PolyView shortcut.
Corrected processing of dragged files containing slide show scripts.
212 Added the optional display of the image file name during full screen mode.
211 Fixed a bug which caused JPEG file handle ownership to be retained.
Added File:Image Properties command.
Added image context menu from right mouse button.
210 Added scripted slide shows.
Added copy and paste operations.
Added support for reading 1, 4, 16, and 32 bit BMP files, and 4 and 8 bit RLE BMP files.
Added background operation of color manipulation, rotation, and image exporting operations.
2.00 Removed image configuration file usage.
Changed image appearance algorithms to work on all systems.
Added gray scale operation.
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Added image save operations.

Improved capabilities for reading damaged files.

Added Register File Types dialog box.

Added context sensitive help.

Added TIFF file support.

Added 24 bit BMP support in 256 color modes.

Added File:Delete option.

Added photo-cd upsizing option.

Added photo-cd file support.

Added system registry use for file association.

Added slide show viewing mode.

Added properties dialog and additional JPEG decompression options.
Added full screen viewing mode.

Added "on-the-fly" image painting during file reading.
Remember last screen position and state.

Remember last directory used to open a file.

Added support for 8 bit color modes.

Added JPEG DCT method choice.

Changed bitmap algorithms for better Win95 compatibility.
Added default saving for application and image configuration defaults.
Added “View:Resize to fit” command.

Initial release.



Register File Types

The Register File Types dialog is accessed through the Register File Types selection of the Options
menu. This dialog provides direct control over the file extensions which the Windows NT File Manager or
the Windows 95 Explorer associate with PolyView. Once this association is made, running the image file
or slide show script file will result in the launching of PolyView and the display of the image or slide
show.

The dialog box offers file types with their most common extensions:
Bitmap image files (.bmp)
GIF image files (.gif)
JPEG image files (.jpg and .jpeg)
Photo-CD image files (.pcd)
PNG image files (.png)
TIFF image files (.tif and .tiff)
Slide show script files (.pvs)

When the dialog OK button is pressed, the Registry file associations for the checked extensions will be
updated, replacing any previous association for those extensions. Press the Cancel button to close the
dialog without making any changes.



Saving and Exporting Files

PolyView saves files in the following formats:

8 bit Windows BMP

8 bit Windows Run Length Encoded (RLE) BMP
16 bit Windows BMP

24 bit Windows BMP

GIF

JPEG

PNG

The save format is determined according to the user operations performed, and the original format of the
image to be saved.

If the Save selection from the File Menu is made, then the image is saved in the same format as the
original format of the current image, and replaces the original input file. The Save selection is only
enabled if the original image format is one of the formats supported by PolyView for file saving.

If the Export Image... selection from the File Menu is made, the Export Image dialog box is invoked.
The save format is specified by the user by selecting the format from the Files of Type: drop down list in
the Export Image dialog box.

If the Yes response is chosen from the Save changes to <filename> dialog invoked when closing a
modified image, and the original format is one of the formats supported by PolyView for file saving, then
the modified image will replace the original image in the input file. If the format of the current image is
not supported for saving, then the Yes response will invoke the Export Image dialog box where the new
name and format for the file can be specified.

See also:

JPEG Properties



Edit Menu

Copy Full Image

Copies the current image to the Windows clipboard. The entire image is copied, not just the currently
displayed portion.

Copy Visible Image
Copies the currently displayed portion of the current image to the Windows clipboard.

Paste
Creates a new image window from any bitmap currently stored in the Windows clipboard.

Flush Clipboard
Removes all information from the Windows clipboard.



Slide Show Scripts

Script File Operations

Slide show script files contain a list of image file names to be included in a slide show. The ordering
of the file names in the script determines the order the images will be displayed during the slide
show.

Slide show script files should be stored in a text file with the file type PVS. When a file with the type
PVS is opened by PolyView, the contents are read and the slide show is started. If the PVS file type
has been registered for PolyView through the Register File Types dialog, then Windows 95 Shortcuts
or Program Manager Program ltems can be created for the script file.

Rotation Options

In some cases, particularly with photo-cd images, the default orientation of an image is incorrect.
Script files can therefore contain rotation options for each individual file. A rotation option is a
character string of the form "/rn" attached to the end of a line in the script file for a specific image,
where "n" is in the range from 1 to 3 and indicates the number of 90 degree clockwise rotations to be
applied to the image prior to display. For example, if the following lines are stored in a file named
"slideshow.pvs"

c:\images\image1.jpg
d:\images\image2.pcd /r1
c:\images\image3.bmp

then the images "image1.jpg", "image2.pcd", and "image3.bmp" will be displayed in the order shown,
with "image2.pcd" rotated clockwise 90 degrees from its "normal" orientation.

Timing Option

A timing options is a character string of the form “/ts” attached to the end of a line in the script file for
a specific image, where “s” is in a non-zero number specifying the display time for the image named
on that line. For example, if the following lines are stored in a file named “slideshow.pvs”

c:\images\image1.jpg
d:\images\image2.pcd /t100
c:\images\image3.bmp

then the images “image1.jpg” and “image3.bmp” will be displayed for the time which is specified by
the Browsed Image Display Time property of the Browsing Properties Tab of the Properties dialog,
and “image2.pcd” will be displayed for 100 seconds.

Saving Script Files

Each time a slide show is displayed during PolyView operation, the list of files and their rotation options
are maintained in memory. When the Slide Show option of the Eile menu is invoked, the current slide
show list is displayed in the dialog box. At this point the files in the show can be removed or have their
rotation options changed, or new files can be added. After the slide show is started and then stopped,
the Save Slide Show option of the File menu can be invoked to create or change a script file. By using
this mechanism, script file creation and editing can be accomplished entirely within PolyView, minimizing
the chances for creating script files with incorrect formats.






8 bit Windows BMP files contain up to a 256 element color table and the uncompressed bits which make
up the image - one byte per pixel. The pixel data from 24 bit images will be color reduced for storage in
this format.



8 bit Windows RLE BMP files contain up to a 256 element color table and the run length encoded bits
which make up the image. The pixel data from 24 bit images will be color reduced for storage in this
format. The storage size for this format may be smaller than an uncompressed 8 bit Windows BMP file,
particularly when an image has large areas of constant color. In some cases, however, an RLE file will
be larger than an uncompressed image.

Note: this storage option is only available to registered users.



16 bit Windows BMP files contain the uncompressed bits which make up the image - two bytes per pixel.
Up to 65536 colors can be represented by this format, using 5 bits for red, 6 bits for green, and 5 bits for
blue. This format is only available for storing 24 bit images.

Note: this storage option is only available to registered users.



24 bit Windows BMP files contain the uncompressed bits which make up the image - three bytes per
pixel. Up to 4 billion colors can be represented by this format. Note that this format is only available for
storing 24 bit images.



All images can be saved to JPEG format files. 256 color image such as those produced from GIF files,
however, may create JPEG files which, although much smaller than the original GIF file, have
considerable visual distortion as compared to the original. You should compare the exported JPEG file

against the original image and experiment with the JPEG Output Quality Factor to achieve the best
results.

If the embedded comments for a file have been updated from the Image Properties dialog box
accessible from the File menu then these comments will be written to the JPEG file as marker text. Note
that this option is available only to registered users of PolyView.



The behavior when multiple files are selected from an Explorer dialog depends on the current PolyView
property options, and the types of files that are selected. In particular, if Replace Current Window has
been selected from the Image File Open Actions property, or if any one or more of the files selected is a
slide show script file, then a slide show will be created. Otherwise a window will be opened for each file
selected and a separate thread will begin reading each image.

Note: multiple file selection is available only to registered users of PolyView.



The Register program is a creation of Grzegorz (Greg) Kochaniak, who is also the author of the
SnapShot/32 screen capture utility. To contact Greg for information about Register, SnapShot/32, or
other software that he has available, send electronic mail to gregko@kagi.com, or check his WWW
page at http://198.207.242.3/gregko/gregko.htm.



PNG, or Portable Network Graphics Format (pronounced ping) is a new format that may eventually
become the standard for lossless image storage. PNG was initially designed to replace GIF, but offers
many features that were lacking in GIF, including higher resolution color, potentially better compression,

and patent free implementation.



Support and Availability

All users are encouraged to communicate praise and problems via e-mail to:
polybytes@kagi.com
Every effort will be made by Polybytes to provide satisfaction.

To see the latest information about PolyView, or to download the most current version, visit our WWW
page at:

http:// 198.207.242.3/authors/polybytes/default.html



All images can be saved to non-interlaced and interlaced PNG formats. Interlaced PNG files use a
complex two-dimensional interlacing scheme that is useful when the file is to be displayed while it is
being received over a relatively slow medium like a serial network link. In these situations the PNG
interlacing scheme allows a highly intelligible view of the image to be displayed when only a small
portion of the entire image has been received. If PNG files are only to be displayed by viewers like
PolyView, then the non-interlaced format will display faster and will be slightly smaller.

If the embedded comments for a file have been updated from the Image Properties dialog box
accessible from the File menu then these comments will be written to the PNG files as comments
identified by the Comment keyword. Note that this option is available only to registered users of
PolyView.



All images can be saved to non-interlaced and interlaced GIF formats. Interlaced GIF files use a scheme
that is useful when the file is to be displayed while it is being received over a relatively slow medium like

a serial network link. In these situations the GIF interlacing scheme allows a partial view of the image to

be displayed when only a small portion of the entire image has been received.

GIF files can contain at most 256 colors. The pixel data from 24 bit images will be color reduced for
storage in this format.

If the embedded comments for a file have been updated from the Image Properties dialog box
accessible from the File menu then these comments will be written to the GIF files as comment records.

Note that saving to GIF format is available only to registered users of PolyView.



MRU File List Properties

The Most Recently Used (MRU) File List Properties are available under the MRU Files tab of the
Properties dialog. The following options are available for manipulating the properties of the MRU file list:

# of files in MRU file list

Controls the maximum number of files in the MRU file list. This can be any number between 0 and
16 inclusive, where 0 indicates that the MRU file list should always be empty. Note that changes in
this option will not take effect until PolyView is restarted.

Purge MRU file list on exit

When this option is checked the MRU file list will behave normally while PolyView is executing, but
will be emptied when PolyView is closed. PolyView will then always start with an empty MRU file list.



LZW-GIF Licensing Information

The Unisys Corporation owns U.S. Patent 4,558,302, and foreign counterparts, and has the right to
grant licenses for the use of this technology. Polybytes has licensed this technology, subject to the
following restrictions for registered users:

A single user PolyView license is restricted to being used on a single computer. If a registered
version of PolyView is to be used on multiple computers, then the agreement requires that an
additional registration be purchased for each computer.



Print Page Setup Dialog

PolyView uses the specification for the top, bottom, left, and right margins to define the area on the
printed page where an image will be placed. Note that PolyView always preserves the aspect ratio (ratio
of height to width) of an image or the visible portion of an image. Within that restriction an image will be
expanded in all directions to fit within the specified margins. The Page Setup dialog box displays and
changes the settings for the margins .

Units

This drop down list sets the dimensional units used to interpret the margin settings for printing. The
available units are inches, centimeters (CM) and millimeters (MM).

Top Margin
The distance from the top of the printed page to the top of the printed image. The actual distance
used may be different if Center Vertically is selected.

Bottom Margin

The distance from the bottom of the printed image to the bottom of the printed page. The actual
distance used may be different if Center Vertically is selected.

Left Margin

The distance from the left edge of the printed page to the left edge of the printed image. The actual
distance used may be different if Center Horizontally is selected.

Right Margin
The distance from the right edge of the printed image to the right edge of the printed page. The
actual distance used may be different if Center Horizontally is selected.

Center Horizontally

If selected then an image which does not fill the area defined by the right and left margins will be
centered between those margins.

Center Vertically

If selected then an image which does not fill the area defined by the top and bottom margins will be
centered between those margins.



New Image Dimensions

The New Image Dimensions dialog is used to specify the dimensions of a new image which is to be
created from an existing image.

Height and Width
Enter the height and width, in pixels, of the new image to be created.

Full or Visible Image

If Full Image is selected then the resulting image will be based on the entire contents of the source
image. If Visible Image is selected then the resulting image will be based on only the portion of the
source image that was visible when the dialog was invoked.

Interpolate

If selected then an interpolation algorithm will be used to generate the final image. This algorithm can
significantly enhance the appearance of the resulting image when the final image is larger than the
source image. It may or may not improve the appearance of an image whose size is being reduced.

Retain Aspect Ratio

If selected then the original aspect ratio (ratio of width to height) of the source image will be taken
into account whenever the height or width values are changed, and the corresponding dimension will
be automatically updated. For example, if the height is changed then the width value required to
maintain the source aspect ratio will be calculated and inserted into the width field.



Transparent Color Specification

Graphics Format Information (GIF) files can include the specification of a color which is to be treated as
transparent by the decoder of the file. Although PolyView displays this transparent color using the
specified color, World Wide Web browsers will display the current background color or pattern in the
transparent areas, resulting in the display of irregularly shaped or overlaid images on web pages.

The Choose Transparent Color dialog is used to specify the color in the current image which is to be
output as the transparent color if the image is exported or saved to a GIF file. The dialog displays the
current palette for the image and a check box which enables the output of a transparent color to the GIF
file. Up to 256 colors are displayed in the dialog. Either the color map from the input image will be
displayed, or the 256 colors which were calculated for an image which did not include a color map.
Clicking on a color will select it as the transparent color, and will cause the display of the Red, Green,
and Blue intensities for the chosen color.



The intensity of a color component varies from 0 to 255. The color 0,0,0 is black and the color
255,255,255 is white.






